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Human Resources CRM Introduction
 
Customer Relationship Management (CRM) is a method for managing customer contacts.  It was developed
from a commercial perspective where businesses needed a way to keep track of their customers, the customer's
contact information and interactions that occurred with these customers, e.g. sales orders, requests for product
quotes, etc.  CRM is not new.  Businesses were managing the relationships they had with their customers long
before the invention of the computer.  Howerver, in our computer-driven culture if you hear the term CRM, it is
usually in conjunction with a software application.  The CRM software application that WSU has implemented is
Salesforce.
 
Salesforce, as the name implies, was developed for processing customer sales.  Although WSU Human
Resources does not sell products to customers, it does provide services to customers.  Who are HR's
customers?   WSU employees and those who are affiliated with WSU.
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Log into SalesForce
 
 

 
 

Address Bar
 

 
Enter hrcrm.wayne.edu into your browser address bar.  Hit the Enter key or click the Go button.  A login
prompt will display.
 
There are two configurations of the log in prompt.  Which one displays will be dependent on whether or
not you have an AccessID authenticated (e.g. Pipeline, Webconnect, Blackboard, etc.) session open
in the same browser.  If you have an authenticated session open, single sign-on is invoked.  If not, you
must log in with your AccessID and Pipeline password.
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Logging Into Salesforce With Single Sign-on
 

 

 
If you are currently logged into Pipeline, Webconnect or Black board, single sign-on is invoked.  Enter
hrcrm.wayne.edu into your browser address bar and hit Enter.  The prompt above will display.

Submit (button)

Click the Submit button to launch Salesforce.
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Logging Into Salesforce With AccessID and Password
 
 
 

 
Enter hrcrm.wayne.edu into your browser address bar and hit Enter.  When you are not logged into Pipeline,
Webconnect or Blackboard, the login prompt above will display.

Access ID

 
Enter your WSU AccessID and tab to the AccessID field.
 

Password

 
Enter your Pipeline password into the Password field.
 

Submitt (button)
 

 
Click the Submit button to launch Salesforce.
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Salesforce Application Layout
 

 
The screen layout above is the basic layout for all tabs.  The content design of each tab may vary, but the
overall look will remain the same.

Tab Bar

 
The Tab Bar, as shown in this graphic, displays the default layout.  However, optional tabs can be
added to the bar and the order of the tabs can be changed.

Navigation Panel

 
The Navigation Panel provides quick, easy access to functionality that is tab dependent.
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Tab Content Area

 
This area displays the tab content.
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Home Tab
 

 
This screen will display when the user logs into SalesForce.  The Home tab is the default "active" tab.  The
Dashboard area is customizable.
 

Search

 
The Search funtion allows the user to search on any item or object within Salesforce, e.g. case
numbers, reports, groups etc.

Content Area
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User Menu
 

 
This menu enables users to create a profile, make changes to various account and desktop
parameters, and log out of the current Salesforce session.
 

 

Help & Training
 

 
 
Because Salesforce CRM was developed to support a sales environment, much of the help and
training is developed from a sales perspective using sales jargon.  However, there are some help
topics that can provide the user with good information.
 

Call Center
 

 
This function not currently used at WSU.

Tab Bar/Tabs
 

 
Each tab on the Tab Bar contains a group of related functions with a distinct layout.  The Tab Bar is
completely customizable.
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Create New
 

 
This section of the navigation panel allows users to quickly create calendar events, e.g. appointments,
tasks for an action or todo list, a new case, upload a file, a new report, and a new solution.
 

 

Recent Items
 

This section of the navigation panel displays a user's most recent activity with the CRM.  From
creating cases, to uploading documents (files), to communicating with other CRM users, the user can
quickly revisit recent activity.
 

Custom Links
 

This section of the navigation panel contains links to commonly referenced WSU websites.  These
links are customizable by the WSU Salesforce Administrator.
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Chatter Tab
 

 
The Chatter Tab functions as the collaborative "home base" and gives you instant access to most of the
collaboration features.
 

Chatter Tab
 

 
The Chatter tab is the collaboration home base and give the user instant access to most of the
collaboration features in Chatter.
 

Messages
 

Clicking the Messages link will display your list of messages.
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Chatter Views

Clicking a Chatter View will change the content that is displayed in the Content Area.
 
 
Chatter Tab Uses
 

The user can accomplish all of the following from the Chatter tab:
 

• Make a post that’s shared with people who follow you, or comment on
someone else’s post.

• Like posts or comments to show your support.
• Share a post to your profile or to a group, or send a link to the post to other

Chatter users in an email or instant message.
• View, filter, and sort your feed on the left side to view posts from people and

records you follow and groups you’re a member of, posts that mention you,
posts you bookmarked, or all posts from your company.

• Search the feed to quickly find information in the feed posts and comments
on the Chatter tab.

• Bookmark a post to keep track of future comments on the post, or to
remember to follow up on the post later.

• Add topics to a post to categorize the post and give it more visibility.
• Access your people, groups, files, and topics lists.
• View or update your profile, such as your profile photo or your contact

information.
• Read or send private messages that are only visible to certain people.
• Access your favorites to see the latest posts and comments for your favorite

topics, list views, and Chatter feed searches.
• View your recommendations for people, groups, files, and records that

closely relate to your job and interests.
• View trending topics that people are discussing in Chatter right now.
• Invite people to join your Chatter network if they don't have Salesforce

licenses to use Chatter.

 

https://help.salesforce.com/HTViewHelpDoc?id=collab_status_update.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_feed_like.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_feed_sharing_post.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_feed_filters.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_feed_search_in_groups.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_feed_post_bookmarking.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_topics_add.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_people_overview.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_group_overview.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_files_overview.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_topics_overview.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_profile_overview.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_message_overview.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_favorites_overview.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_recommendations.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_trending.htm&language=en_US
https://help.salesforce.com/HTViewHelpDoc?id=collab_invite.htm&language=en_US
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Profiles Tab

 
Customize your Profile with a photo and information about yourself so others can learn more about you.

Profile Tab

 
Click the Profile tab to customize the users profile with a photo and information about themselves.

Edit Profile Button

Click this button to edit your profile or access your personal settings.
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Feed Tab

Click the Feed tab to view your Chatter feed or post an update.

Overview Tab

Update your About Me section, view your groups or see who is following you and who you are
following.

User Photo

Click your photo to add or change the photo.

Contact Information

Click the pencil icon to edit your contact information.
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Contacts Tab
 

 

 
 
The Contacts tab provides you with the ability to view personal, employment, and job information about any
contact that has been loaded into the CRM database.
 

Contacts Tab

Click the Contacts tab to display contact information.
 

Contacts View Control

Selecting an option from the View pull-down list (shown below) and clicking GO will give you some
control which contact information is displayed.
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Recent Contacts (List)
 

 
Recent Contacts are displayed in this area as a result of clicking Recent Viewed Contacts from the View pull-
down list and clicking GO.
 

Recent Items

 
You can also display recently viewed contacts from the Recent Items section of the navigation panel.
  Names in this list are the result of either reviewing contact information of Chats that you make or by
other users you are following.  Numbers are recently viewed or created Case Numbers.
 
By hovering your mouse pointer over an entry, a summary pop-up will display.
 
If it was a recently viewed contact, the pop-up will look like this:
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If it was a Chat response, the pop-up will look like this:
 

 
Note:  Numerical values contained in the list are Case numbers.
 

 

Contact Reports

 
This section provides reports that are specifically associated with contacts.

(Contact) Tools

 
To be determined.
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Cases Tab
 
 

 
Creating a Case is the method for documenting an interaction with an Contact.

Case Tab

Click the Case tab to display Case information.

Case View Section

 
Selecting an option from the View pull-down list (shown below) and clicking GO will give you some
control which combination of cases are displayed.
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Recent Cases

 
Recent Cases is display in this area as a result of clicking Recently Viewed Cases from the View
pull-down list and clicking GO. The layout and information displayed will vary with the selection from
the View pull-down list.

Recent Items

 
You can also display recently viewed cases from the Recent Items section of the navigation panel.
Numerical values in the list are case numbers.  You can hover your mouse pointer over the case
number to display a brief summary of the case.
 
 
The pop-up for a recently viewed case will look like this:
 

Note:  Name values contained in the list are the result of Chat interactions.
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Reports

This section provides reports that are specifically associated with cases.

(Cases) Tools

 
To be determined.
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Reports Tab
 

Reports give the user access to data that has accumulated over time. The data can be displayed in almost
infinite combinations and can be share with others via dashboards.

Report Folders

 
System report are sorted into folders.  Folders are used to categorize report types.  Click the folder
name to display a list of the reports contained in that folder.

Report Actions

Actions to be taken by report developers.  Click the button to display the actions.
 



 

23

Report Category
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Solutions Tab (Optional)
 

 
 

Solutions Tab
 

 
Clicking the Solutions tab displays the Solutions home page.

 

Find Solutions
 

 
Enter key words to search for a solution. 

Solution Views
 

Browse for solutions by category name and sub-category.
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Recent Solutions
 

 
Click the solution title to display the solution.

Reports
 

 
Display a list of solutions.
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Groups Tab (Optional)

 
The Groups Tab displays a list of the Chatter groups in the organization.
 

Groups Tab

 
The Groups tab display your Chatter Groups.

New Group

Click the New Group to create a new Chatter Group.

Group Views

Click a Group View to display the groups by category.
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Locating an Employee's Contact Information
 

The first time you attempt to locate an employee's contact information after logging in, you must use the
Search function at the top of the screen.  Subsequent searches can be performed from the search box that
displays with the results of your initial search.
 

 
After obtaining the employee's WSU Access ID or his/her last name:

Contacts Tab

Click the Contacts tab (unless already selected) to locate the contact information for a WSU
employee.

Search Entry Field

Enter the employees last name in the Search box.

Search Button

Click the Search button to initiate the search.
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Search Results

This search produced two results, click the appropriate employee's name to open his or her contact
information.
 
 
The contact information for this employee will display.
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Working With Cases
 
 
Issues brought to the attention of the Employee Resource Center (ERC) are documented by creating a case.
  The case can be retained within the ERC for resolution, assigned to a Response Queue or assigned to an
individual user.
 
The case contains the following information:
 

• The case number
• The case owner (person responsible for providing a solution/response to the contact.
• The name of the contact and the contact information
• Case status, a description of the issue, the date the case was created, and how the case came to the

ERC.
• Case comments, case history, and any related cases.
• If the case is closed, how the case was resolved.
• Open activities and activity history.
• Attachments (supporting documentation) that may have been applied to the case.
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Creating a Case for a WSU Employee
 
 

 
Creating a Case is the method for documenting the interaction with a contact.
 

Contact Information

 
To create a "Case" for an employee issue, you must first locate the employee's contact information. 
Follow the step described in the section Locate the Employee's Contact Information.
 

Cases Section

 
The Cases section is located toward the bottom of the screen after the last of the employee's
information.

Case Button

Click the New Case button to open a new case screen.
 
See Completing a New Case for instructions on entering information into the New Case fields.
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Creating a Case For a Non-Employee
 

 
 
Creating a case for a non-employee differs in the way in which the case is created.

Create New

 
Click Create New... to activate the pull-down menu.

Case

 
Click Case to create a new case for a non-employee inquiry.
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Description (field)

 
Enter the contact information in the Description field.  Enter the case description after the contact
information.

New Case Screen
 

 
The New Case screen is displayed in the Edit mode and is ready to be completed.

Contact Name Blank
 

The Contact Name field is blank because the new case was not created from an employee's Contact
screen.  When a new case is created from the employee's Contact screen, the employee's name is
inserted in the Contact Name field.
 
Leave the Contact Name blank!
 
The Contact Name for non-WSU contacts must be entered into the case description field.
 
CAUTION:  Do not click the Contact Name Lookup button to the left of the Contact Name field to add
a contact name.  Only WSU employees and those associated with  Wayne State have contact records
in Salesforce.
 

 
See Completing a New Case for instructions on entering information into the New Case fields.
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Completing a New Case

 
A well constructed case will help ensure a timely and accurate resolution of the case.
 

Case Owner

For a new case, the originator of the case is the default Case Owner.  The Case Owner may retain
control of the case to resolve it on his/her own or can allow the case to be reassigned to a designated
case queue.  When a case is reassigned to a queue, the queue becomes the Case Owner.

Contact Name

 
The Contact Name contains the name of the qualified WSU employee/associate when the case is
created from the Contact.
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Status

 
New is the default Status for a newly created case.

Case Origin

 
Case Origin indicates how the issues was brought to the ERC.  Walk-in, Email, Mail (Post) and Web
are additional options.

Priority

 
The default Priority is Medium.  High and Low are also options.

Type

Type gives insight into the type of case being created.  Question, Info Request and Service Request
are also options.

Case Topic

Case Topic provides a high-level classification of the case.  Case Topic also plays a role in the routing
of the case to the proper queue.

Case Topic - Detail

Case Topic - Detail provides a second-level classification of the case.  In combination with the Case
Topic the case can be routed to a specific queue where the case can be resolved by subject-matter
experts.
 

Subject

 
The Subject field allows the case originator to further refine the description of the case.  This field also
appears on the Cases screen with the case number.

Description



 

35

The Description field is where the details of the case are entered.  A well developed description will
provide the necessary detail for the case to be resolved.  The description is included in an email to the
contact if Send Notification Email to Contact is selected.

Internal Comments

Internal Comments are intended for internal use are NOT included in the email to the contact.

Options

 
With the Assign Using Active Assignment Rules checkbox selected, the case will be routed to the
queue identified by the Case Topic and Case Topic - Detail.  If the originator of the case (current
Case Owner) chooses to retain control of the case, they can do so by unchecking the checkbox.
 
The Send Notification Email to Contact checkbox, by default, is unchecked.  If the Case Owner
decides to send this notification to the contact, they must check the checkbox.

Save

Clicking the Save button saves the case and have the system assign a case number to the case.

Save & New

Clicking Save & New saves the case (system assigns case number) and creates a new case using
the same contact information.  Use this option if the contact has a second issue that is related to the
first case or has a second unrelated issue.

Check Spelling

Unlike many word processors, Salesforce does not do simultaneous spell checking.  If you want to
spellcheck your case, you must click the Check Spelling button.

Cancel

Click Cancel to cancel the current case prior to assigning a case number.
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Open an Existing Case

 
Click the Cases Tab to display the list of cases.
 

View (Cases)

 
The default display for the Cases Tab is to list the most recently viewed or modified cases for the user.
  View option enable you to view the cases by different classifications:
 

Recent Cases

 
The most recently viewed case appears at the top of the list.
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Existing Case Entry

 
When you locate the desired case, click either the Case Number or Subject to open the case.

Display Selection

By clicking the Display Selection, you can select Recently Viewed cases to display cases you have
viewed recently (whether you are the owner or not) or My Open (cases) to display only cases that you
own.
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Viewing an Existing Case
 

 

 
Once you have located a case on the cases home or list pages, click the case name to display the details.
 

Case Number

Case Action Buttons

These button appear at the top of the displayed case and near the center of the case layout.  They
provide editing functionality with regard to the case.  They will be addressed in another section.
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Case Detail

This section displays summary information about the case:
 
Case Owner: This field contains the current case owner.  If you have created the case and have not re-

assigned the case to another user, your name will appear here.
 

Case Number: The case number is the system-assigned number given to the case when it was created.
 

Contact Name: This is the individual who initiated the contact.  If there is a name in the field, it is the
name of a qualified WSU employee.  If the field is blank, the interaction was initiated by
and individual who is NOT a qualified WSU employee.  The name of this individual will
appear in the Subject field of the case comments.  The Subject field can be viewed in the
Additional Information section of the displayed case.
 

Contact
Phone:
 

The contact phone number of the WSU employee who initiated the contact.
 
Note:  The contact phone number for a Non-WSU employee who initiates a contact will
be in the Description field of the displayed case.
 

Contact Email: The email address of the WSU employee who initiated the contact.
 
Note:  The email address for a Non-WSU employee who initiates a contact will be in the
Description field of the displayed case.
 

Type (of
contact):

The Type field establishes the type of contact.
 
Example:

Case Topics:
 

Case Topic classifies the type of contact into general categories.
 
Example:  Employee Benefits

Case Topic -
Details:
 

Case Topic - Details further classifies the contact into specific areas of the topic.
 
Example:  Retirementy Savings Plans

Parent Case: If the currently displayed case does not have a related case(s), this field will be blank. 
If the currently displayed case is related to and is subordinate to another case, the other
case will be the Parent Case and its case number will be displayed here.
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Additional Information

A right-pointing arrow next to a section title indicates that section is collapsed.  To expand the
section and display its content, click the right-pointing arrow.  To collapse a section to hide its
contents, click the down-pointing arrow.
 

Status: Indicates the status of the currently displayed case.  Status indicators are:  New,
On Hold, Escalated and Closed.
 

Case Origin: Describes how the contact was initiated.  Methods of originating cases include: 
Phone, Walk-in, Email, Mail (US Postal) and Web.
 

Priority: Importance indicators include:  High, Medium and Low
 

Subject: This field enable you to clearly describe the purpose of the contact.
 

Description: The Description field allows you to further define the case.
 

Date/Time Opened: This field indicates the date and time the case was created.
 

Date/Time Closed: This field indicates the date and time the case was resolved and closed.
 

System Information

A right-pointing arrow next to a section title indicates that section is collapsed.  To expand the
section and display its content, click the right-pointing arrow.  To collapse a section to hide its
contents, click the down-pointing arrow.
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Case Comments
 

 
This section provides a section for various users to add, edit or delete comments relative to the
case.  These comments can remain private or can be made public to all users.
 

Case History
 

 
The Case History tracks changes to the case.  Any time a user modifies any of the standard
or custom fields a new entry is added to the Case History related area.  All entries include the
date, time, nature of the change, and who made the change.
 

Related Cases
 

 
The Related Cases list displays all of the cases directly below a parent case in a case
hierarchy. Cases can be associated with each other via the Parent Case lookup field on a case
edit page. When a case is associated with a parent case it signifies a relationship between
cases, such as a grouping of similar cases for easy tracking.
 

Solutions
 

 
This section links to a list of Solutions.  The search function searches all fields that exist on a
solution.
 

Open Activities
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The Case History related list of a case detail page tracks the changes to the case. Any time
a user modifies any of the standard or custom fields whose history is set to be tracked on the
case, a new entry is added to the Case History related list. All entries include the date, time,
nature of the change, and who made the change. Modifications to the related lists on the case
are not tracked in the case history
 
 

Activity History

 
The Activity History related list of a record displays all completed tasks, logged phone calls,
saved interaction logs, expired events, outbound email, mass email, email added from Microsoft
Outlook®, and merged documents for the record and its associated records.

 

Attachments
 

 
You can attach files—such as Microsoft® Office documents, Adobe® PDFs, and images and
videos—to most kinds of Salesforce records.
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Editing an Existing Case
 

 
There are two ways to edit a case:  case edit mode or edit field by field.
 

Case Edit

 
Clicking the Edit button will place the entire case into edit mode.  All editable fields will be displayed.
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Field Locked
 

 
If a Closed Lock icon appears near a field when it has been selected, that field cannot be edited.
 

Edit Field
 

 
If a Pencil Icon appears near a field when it has been selected, you can enable the field for editing by
double-clicking the pencil icon.
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Reassigning a Case To a New Owner
 

 
To re-assign a case to a new owner, first open the desired case.

Case Owner

 
Click the Change link to the right of the current Case Owner (Benefits).  The Change Case Owner
screen displays.  There are two options for reassigning the case.  The case can be reassigned to a
specific User or to a Case Queue.  If reassigning to another user, click the Lookup button to the right
of the lookup field.
 

 
  A Lookup screen will display.  Enter the new owners last name in the Lookup field and click the Go!
button.
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Click the name of the user you want to assign as the new Case Owner.
 

 
Click Save to complete the reassignment.
 

 
The case has been reassigned to a new Case Owner.
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Routing a Case To a New Response Queue
 

 
To reassign a case to a Response Queue, first open the desired case.
 

Case Owner
 

 
Click the Change link to the right of the current Case Owner's name.  The Change Case Owner
screen will display.
 
Click the down arrow for the Owner field and select Queue from the drop-down list, then click the
Owner Lookup button.
 

 
When the Lookup screen displays, select the appropriate Queue from the Search Results list and
click the Go! button.
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Verify the Send Notification Email checkbox is selected (Queue owners will receive notification of
new case in queue) and click Save.
 

 
Case Owner has been updated.
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Closing a Solved Case
 

 
To close a case, open the desired case and click either Close Case button.  A Close Case edit screen will
display.
 

Status
 

 
Change Status to Closed.

Case Reason
 

 
Select a Case Reason from the drop-down list.

Internal Comments
 

 
Enter any additional closing Internal Comments (contact does not see these comments).  Enter
None if there are no additional closing comments.
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Case Topic Detail
 

 
Select the appropriate Case Topic Detail from the drop-down list.

Case Topic

 
Select the appropriate Case Topic from the pull-down list.

Case Topic - Detail

 
Select the appropriate Case Topic - Detail from the drop-down list.

Submit to Public Solutions
 

 
By leaving the Submit to Public Solutions checkbox checked, the Solution Title and Solution
Details will be will create a Solution and post it in the Solutions library.

Solution Title
 

 
Enter a Solution Title.  If this solution will be added to the library of solution, please word the title as a
question.

Solution Details
 

Enter Solution Details here.  If this solution will be added to the library of solution, please list the action
that were taken to resolve this issue.

Save
 

 
Click Save to save and close the Close Case edit screen.
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Working With Tasks
 
 

In the process of resolving a case, you may need to take specific actions, e.g. make a phone call, send an email,
schedule a meeting, etc.  These actions can be entered into Salesforce as Tasks.  A Task can be related to a
case, a contact or just a task you must perform that is not related to a specific case or contact.
 
A New Tasks can be created from:
 

• Home Tab
• Navigation Panel
• Open Case
• Open Contact

 
Tasks created from the Home tab or Create New (Navigation Panel), are not automatically related to a case or a
contact.  To relate these tasks to a case or a contact, you must manually create the relationship.
 
Tasks that are created from an open case or open contact are automatically related to the case or contact from
which they were created.
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Creating a New Task From an Open Case
 

 
In the process of resolving an issue, you may find that you must take an action that is outside the ordinary
steps for resolving this type of issue.  You may need to make a phone call to a department outside of Human
Resources or to a vendor.  You may have to meet with someone face-to-face to get an answer.  These and many
other actions are referred to as Tasks.
 
When you create a Task from an open Case, some of the fields will auto-populate from the Case data.

Case Number

Open the desired case from the Case tab, Recent Items, of from the Contacts record.
 

Open Activities

Scroll to the Open Activities section.
 

New Task Button

Click the New Task button.
 
See Completing a New Task for instructions on entering information into the New Task fields.
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Creating a New Task From an Open Contact
 

 
If a Task relates to an employee but not a case, you can create the Task from the employee's contact screen.
 

Contact Record
 

 
Open the desired Contact record.

Open Activities
 

 
Scroll to the Open Activities section.

New Case Button

 
Click the New Case button.
 
See Completing a New Task for instructions on entering information into the New Task fields.
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Creating a New Task From The Home Tab or Navigation Panel
 
 

 
If a Task is not related to a contact or case, you can create a New Task from Create New on the Navigation
Panel.  However, if this task is related to a case or a contact, you must be entered information manually
 

Create New

 
Click the Create New pull-down menu.

Task Option

 
Click the Task option.  The New Task screen will display.  Because this Task was not created from a
Case or Contact screen, the fields that would be auto-populated are blank.  If this Task is related to a
Case or Contact, you must manually enter the information.
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See Completing a New Task for instructions on entering information into the New Task fields.
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Completing a New Task
 

 
 

New Task Screen

Notifies you that this is the screen for creating a New Task.
 

Task Edit Section

Indicates the screen is in Edit Mode.
 

Task Information Section

The following fields auto-populate from the Case information:
 
Assigned To field populates with the name of the user who is creating the New Task.
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Related To and Name fields populate with data from the Case.
 

 
Complete the following fields with the appropriate information.
 

Additional Information Section

 
Phone and Email Fields
 
The following fields auto-populate from the Case information:
 

 
Status Field

 
Click the drop-down menu in the Status field.
 

 
Select the appropriate status.
 



 

58

Priority Field
 
Click the drop-down menu in the Priority field.
 

 
Select the appropriate Priority.
 

 

Recurrence

 
If this is a recurring task, you can click the checkbox to display the controls for setting the recurrance.
 

Reminder

 
The default is for the new task  to have a reminder.  Uncheck the checkbox to remove the reminder.
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Working With Events
 
 

As with Tasks, In the process of resolving a case, you may need to schedule specific events, e.g. make a phone
call on a specific day, meet with an individual who is out of the office and will return on a specific day, etc.  Dates
and times can be entered into Salesforce as Events.  An Event can be related to a case, a contact or just a day
you must perform an action that is not related to a specific case or contact.
 
A New Events can be created from:
 

• Home Tab
• Navigation Panel
• Open Case
• Open Contact

 
Events created from an Open Case or Open Contact are automatically related to the case or contact from which
they were created.
 
Events created from the Home tab or Create New (Navigation Panel), are not automatically related to a case or
a contact.  To relate these Events to a case or a contact, you must manually create the relationship.
 
Events are scheduled into the Salesforce calendar.
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Creating a New Event From an Open Case
 

In the process of resolving an issue, you may find that you must schedule a date and time for an action to take
place.  You may need to make a phone call to a department outside of Human Resources or to a vendor who is
not currently available. These and many other scheduled actions are referred to as Events.  When you create an
Event from an open Case, some of the fields will auto-populate from the Case data.

Case Number

Open the related Case.

Open Activities

Scroll to the Open Activities section.

New Event Button

Click the New Event button.  The New Event screen will display.  In the screenshot below, you can see
the fields that were auto-populated.
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Creating an Event From an Open Contact
 

If a Event relates to an employee but not a case, you can create the Event from the employee's contact screen.

Contact

Open the desired Contact.

Open Activities

Scroll to the Open Activities section.

New Even Button

Click the New Event button.  The New Event screen will display.
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Creating a New Event From The Home Tab or Navigation Panel
 

 

 
An Event created from Create New will be a stand-alone event.  It will not be related to a case or a contact.
 

Create New

 
Click Create New in the navigation panel.
 

Event Option

 
Click Event to create a new event.
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Working With Chatter
 

 
Chatter Tab
 
The Chatter tab is your collaboration home base and gives you instant access to most of the collaboration
features in Chatter.
 
From the Chatter tab you can:
 

• Make a post that’s shared with people who follow you, or comment on someone else’s post.
• Like posts or comments to show your support.
• Share a post to your profile or to a group, or send a link to the post to other Chatter users in an email

or instant message.
• View, filter, and sort your feed on the left side to view posts from people and records you follow and

groups you’re a member of, posts that mention you, posts you bookmarked, or all posts from your
company.

• Search the feed to quickly find information in the feed posts and comments on the Chatter tab.
• Bookmark a post to keep track of future comments on the post, or to remember to follow up on the

post later.
• Add topics to a post to categorize the post and give it more visibility.
• Access your people, groups, files, and topics lists.
• View or update your profile, such as your profile photo or your contact information.
• Read or send private messages that are only visible to certain people.
• Access your favorites to see the latest posts and comments for your favorite topics, list views, and

Chatter feed searches.
• View your recommendations for people, groups, files, and records that closely relate to your job and

interests.
• View trending topics that people are discussing in Chatter right now.
• Invite people to join your Chatter network if they don't have Salesforce licenses to use Chatter.

 
Here are a few examples of working with Posts.
 
Making a Post
 
Make a post to let people know what you are working on, to ask questions, and share information.
 

 

1. Above your feed, click Post or just click the text box.
2. Type your update in the text box. You can add hashtag topics and mention people.
3. Below the text box, select My Followers to publish the post on your profile, or select A Group, type

part of the group’s name in the Search Groups field, and select the group from the drop-down list.
4. You can only select a group you’re a member of.
5. Click Share.

 

HTViewHelpDoc?id=collab_status_update.htm&language=en_US
HTViewHelpDoc?id=collab_feed_like.htm&language=en_US
HTViewHelpDoc?id=collab_feed_sharing_post.htm&language=en_US
HTViewHelpDoc?id=collab_feed_filters.htm&language=en_US
HTViewHelpDoc?id=collab_feed_search_in_groups.htm&language=en_US
HTViewHelpDoc?id=collab_feed_post_bookmarking.htm&language=en_US
HTViewHelpDoc?id=collab_topics_add.htm&language=en_US
HTViewHelpDoc?id=collab_people_overview.htm&language=en_US
HTViewHelpDoc?id=collab_group_overview.htm&language=en_US
HTViewHelpDoc?id=collab_files_overview.htm&language=en_US
HTViewHelpDoc?id=collab_topics_overview.htm&language=en_US
HTViewHelpDoc?id=collab_profile_overview.htm&language=en_US
HTViewHelpDoc?id=collab_message_overview.htm&language=en_US
HTViewHelpDoc?id=collab_favorites_overview.htm&language=en_US
HTViewHelpDoc?id=collab_recommendations.htm&language=en_US
HTViewHelpDoc?id=collab_trending.htm&language=en_US
HTViewHelpDoc?id=collab_invite.htm&language=en_US
HTViewHelpDoc?id=collab_add_topic.htm&language=en_US
HTViewHelpDoc?id=collab_add_mention.htm&language=en_US
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Liking Posts and Comments
 
Like posts or comments to show your support and receive email notifications if others comment on that post
 
Below a post or comment, click Like.
 

 
After you click Like on a post, you receive email notifications if others comment on that post. If you click Like
on a comment, only the user who posted the comment receives an email notification, but you receive an email
notification for any subsequent comments.
 

• To stop liking a post or a comment, click Unlike. When you stop liking a post or a comment, you don’t
receive email notifications for subsequent comments or likes.

• View the profiles of others who have liked a post by clicking their name at the bottom of the post or
comment, for example, “John Smith likes this.”

• If more than three people like a post, click the link to see the full list; for example, “You, John Smith,
and 2 others like this.” From that list, you can follow or stop following people.

• Likes on comments show how many people have liked the comment, for example, “1 person” or “7
people”. To see their names, click the link.

 
Sharing a Chatter Post
 

 
You can share public Chatter posts that contain text, links, or files to your profile, with a group, or using a link
to the post.
When you share a post, keep in mind:
 

• You can share a post to your own profile, but not to another person’s profile.
• You can share the original post, including any files and attachments, but you can’t share any

comments or likes.
• You can comment on the shared post, but you can’t edit a shared post.
• You can’t share feed tracked items and custom feed items, such as approvals, dashboard

snapshots, or case interactions.
• You can only share posts with a group you’re a member of.
• You can share a post to a group that allows customers. However, customers and other group

members can’t share posts from a private group.

 

HTViewHelpDoc?id=collab_email_notify.htm&language=en_US
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When someone shares your post, you receive an email notification. To change your email notifications, from
Setup, click My Chatter Settings | Chatter Email Settings.
 
Bookmark a Post
 
Bookmarking a post lets you keep track of posts you’re interested in.
 

 

1. Click the down arrow at the top right corner of the post you want to bookmark to expand the drop-
down list.

2. Click Bookmark.  The bookmark icon displays next to the post to indicate that you successfully
saved the post to your bookimarks.
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Customizing Your Profile
 

Click the Profile tab to customize your profile.

Profile Photo

Hover your mouse pointer over the photo placeholder or your profile photo until the Update/Delete
options appear.  Click Update.
 

 
When the Upload Profile Photo dialog box displays, browse your PC until you locate your profile
photo.  Click the Show My Photo on Publicly Accessible Pages, so your photo will display.  Click
Save.
 

 
Your Profile Photo has been updated.
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Contact Information Control
 

To enter or edit your contact information, click the Pencil icon near the word Contact.  The Edit
Profile dialog box will display.
 

 
Before clicking the Save All button, you can add/edit addition information about yourself.  Click the
About tab.
 

Click the Save All button to save your changes and exit the Edit Profile dialog box.
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CRM Process Maps
 
Becoming familiar with Salesforce is the easy part.  How you use it in the ERC is the real challenge.  This section
describes the how and the when to use it to achieve its real purpose:  resolve human resource issues.  Using a
series of workflow maps, the overall process and its segments are clearly defined.
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Basic CRM Process
 

This process map is intended to give the user a macro vision of what the basic CRM Process looks like.  In
reality, there are additional decisions and actions that take place throughout the process. These decisions and
actions are detailed in subsequent process maps.

 
 


	Title
	Table of Contents
	Human Resources CRM Introduction
	Log into SalesForce
	Logging Into Salesforce With Single Sign-on
	Logging Into Salesforce With AccessID and Password

	Salesforce Application Layout
	Home Tab
	Chatter Tab
	Profiles Tab
	Contacts Tab
	Cases Tab
	Reports Tab
	Solutions Tab (Optional)
	Groups Tab (Optional)

	Locating an Employee's Contact Information
	Working With Cases
	Creating a Case for a WSU Employee
	Creating a Case For a Non-Employee
	Completing a New Case
	Open an Existing Case
	Viewing an Existing Case
	Editing an Existing Case
	Reassigning a Case To a New Owner
	Routing a Case To a New Response Queue
	Closing a Solved Case

	Working With Tasks
	Creating a New Task From an Open Case
	Creating a New Task From an Open Contact
	Creating a New Task From The Home Tab or Navigation Panel
	Completing a New Task

	Working With Events
	Creating a New Event From an Open Case
	Creating an Event From an Open Contact
	Creating a New Event From The Home Tab or Navigation Panel

	Working With Chatter
	Customizing Your Profile
	CRM Process Maps
	Basic CRM Process


